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Preface

Computer

: Computers, a series of eight books, is a carefully arranged Computer series,

that perfectly complies with the NCERT syllabus criteria and the National
Curriculum Framework's vision. In auordance with NEP 2020’s guidelines,
the series adopts an interactive approach to make Learning about
Computer enjoyable for students. This book includes enough questions in
accordance with the NEP criteria. The fundamental principles of NEP which
are recognising, identifying and fostering the unique capabilities of each
student, respect for diversity, and respect for the local context in all topics,
are always kept in mind while creating the book.

The topics are introduced in a way that children experience and learn
through exploration.

Child-friendly language and contextual images have been incorporated
throughout the series to make the material more understandable for young
readers. This allows them to connect what they read and relate it to the
views, ideas and experiences they encounter every day.

Salient Features of the series:

Learning Outcomes

Warm Up
Teacher’s note
Let me answer

Do You know
Remember It

Kids’ IQ

Up skill your
Intelligence
Critical Thinking

Team Work

It shows the right path of learning to the teachers as well as students. It
establishes the direction of learning for efficient and superior learning
results.

: Children can connect their prior knowledge to the chapter's topic through

simple yet engaging activities.

: An outline of guidelines for teachers to follow in the classroom in order to

make lessons interactive and discussion-based.

: Questions related to the topic which are essential for checking pupil

understanding and keeping them engaged with the task at hand.

: An interesfing piece of information related to the topic.

: Additional information about the topic to encourage children to wonder

about various surroundings.

: These questions have been included to reinforce learners to think, analyse

and apply.

: Ample exercises with a range of questions to support learning.

: Questions which allow the learners to think clearly and rationally. Further,

permit the learners to understand the logical connections between ideas in
order to analyse facts and come to a conclusion.

It enables the students to collaborate with others.

The content is structured and well-graded. Sincere efforts have been taken to prevent any
inconsistencies and make this series a perfect complement to the students' education. Any worthwhile
recommendations for how to improve the series are always welcome and greatly appreciated.

Author
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At the end of this chapter, students will be able to:

+ Differentiate between hardware and software.

+ Define the main parts of the computer.

+ Classify the computer parts into input, output and storage devices.
+ Learn about the working of all parts of the computer in detail.

Al

Sound Chair Computer

‘W Teacher’s W4 students that something which a person can see, feel or touch and have a physical
g\j ([PYTYR  existence are called tangible things, whereas the intangible is something which a person
cannot see, feel or touch.
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Hello... we already know about the
basics of computers. Now, we will
learn about the functions of each
part of the computer in detail.

Now, it is time to learn more about
this wonderful machine.

&3 KEY PARTS OF A COMPUTER

We already know that a computer is an electronic device that can do
many tasks simultaneously. A computer system has different parts
that together make it work. Based on processing, computer parts are
divided into two groups:

A
<« >

Hardware

< Software

& HARDWARE

The parts of the computer that can be seen and touched are called
hardware. Hardware refers to all electronic and mechanical parts of
the computer system.

Further, computer hardware parts are classified as follows.
Input devices

< Output devices
Storage devices
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Input Devices

A computer always needs a set of instructions to work. It cannot work
on its own. The devices through which instructions are fed into the
computer system are called Input devices. For example, keyboard is
used to give instructions to the computer by typing.

Other input devices are a mouse, microphone, web camera, light pen
and joystick.

KEYBOARD

Keyboard is the most common input
device. Data and instructions are entered
into the computer using its keys. There are
different layouts of keyboards available
like QWERTY, WASD and DVORAK.
Amongst these layouts, QWERTY is
the most commonly used layout. WASD
keyboard is mostly used by gamers.

A keyboard has different types of keys. These keys are small buttons
on the keyboard keys.

Some of the important keys are:
Alphabetical keys : A, B, C.....Z are alphabet keys. There are 26
alphabet keys.

Numerical keys : 0,1,2....9 are numerical keys. There are 10
numerical keys.

»ﬁ\ 2
&% @ Do You Know?

On most keyboards, you type using all your fingers. There are some keyboards, however, that are
designed specifically for thumb usage known as thumb-sized keyboards.
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Spacebar : This key is used to insert spaces between the
letters. It is the longest key on the keyboard.

Backspace : This key is used to delete any character before
the current position of the cursor.

Arrow keys : These keys are used to move the cursor position
in all directions.

Alphabetical keys Backspace Numerical keys
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Spacebar Arrow keys

A computer mouse is an input device that is used
with a computer. It is a pointing device that can
move the cursor to different items on the screen.
Mouse has two buttons, the left button and the right
button, with a scroll wheel. Today, many

Differentiate between a reall computers use wireless technology and have
mouse and a computer’s mouse. )
no wire.

There are three types of mouse namely wired, wireless and optical:
A wired mouse : A wired mouse is that type of mouse |
that has a wire. It is connected to a

computer or a laptop directly. The transfer of

information takes place through the wire.
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Wireless mouse : It does not have any wire. It is not
connected directly to any system. The
transfer of information takes place in
the form of radio signals.

Optical mouse : An optical mouse uses a light-

emitting diode (LED). Movement

is detected by sensing changes in
WEB CAMERA

reflected light.
A webcam is a camera that connects hi ‘\?
1 Can you do video calling on

MICROPHONE

Microphone is an input device that is used to
to the computer and captures still | using a web camera? | T fBia
pictures or motion videos.

record any sound or voice. It converts sound into
Q LIGHT PEN

an electrical signal.

A lightpen is a light-sensitive pointing input device
that is used to draw things on the computer screen.

SCANNER

A scanner is an input device that is used to scan

any document and print it on paper. We can also
save the document on the computer.

Output Devices

MONITOR
A monitor is an output device that shows the work which we do on
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a computer. It also displays the result and movement of the mouse
pointer on the screen. It is also known as VDU (Visual Display Unit).

There are three types of monitors

1. CRT (Cathode Ray Tube)

These monitors are big in size and consume more power.

2. LCD (Liquid Crystal Display)

These are the monitors with flat screens which consume less power.
3. LED (Light Emitting Diode)

These monitors have a better display. They are thinner and lighter in
weight. They consume 40 per cent less power than LCD.

b E= O

CRT monitor LCD monitor LED monitor

PRINTER

It is a hardware output device that allows a user to print items on
paper. Many printers can also work as photocopiers.

Laser printers

Laser Printers produce high-quality text and graphics. To print text
and images onto the paper, it uses a focused beam of light.

Y
|

Laser printer Inkjet printer Solid ink printer




Inkjet printers

These are also called bubble jet printers and print both text documents
and high-quality coloured images, especially photos. These are cost-

effective as compared to laser printers.
PROJECTOR

A projector is an output device that takes images
generated by the computer and displays them on
a big screen.

Storage Devices

HARD DRIVE

It is a storage device and has flat circular plates
made of aluminium or glass that can store huge

amount of data.
DVD

It stands for Digital Versatile Disk. It is used for
data storage, recording, and playing audios and

videos.

Pen Drive

It is also known as a USB stick that uses
flash memory and can store a lot of data and

applications. It is also used to copy and move

data from one computer system to another.
Memory card

It is a small chip-like device that stores electronic data.

It can also be inserted into a smartphone.
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Processing Devices

CPU

CPU stands for Central Processing
Unit. It is also called the Brain of the
Computer as most of the functioning
of the computer takes place in this
part. It also controls all the other parts
of the computer. CPU has three parts:

Arithmetic and Logic Unit (ALU)

This unit is responsible for all the arithmetic and logical operations
of the computer.

Memory Unit (MU)

Thisunitisresponsible for storingall the information on the computer.
The memory can be volatile or non-volatile.

Control Unit (CU)

This unit controls the functioning of all the other units such as MU,
ALU and devices.
-

REMEMBER IT! | 8%
REMEMBER IT. {8

The CPU sends signals to control the other parts of the computer, almost like how
a brain controls a body.

Software

Softwares are the applications stored in the computer that we cannot
see and touch. These are the set of instructions, data or programs
that enables computers to work. Example of software are MS excel,
MS Word, Tux Paint and many more.

The software can be of two types:




SYSTEM SOFTWARE

System software is designed to run a computer’s hardware and
provides a platform for applications to run. E.g. Operating System.

APPLICATION SOFTWARE

An application is a software that fulfils a specific need or performs
tasks. Example: Paint, Excel, Games, Word etc.

Microsoft Excel | | Microsoft Word
- s Kids’ 1IQ
Write T for input devices and ‘O’ for the output devices.
Keyboard D Microphone D Printer D

& Let’s Recall

« A computer system parts are divided into two groups namely: hardware and
software.

« Hardware is the parts of the computer that we can see and touch.
 Software includes the applications of the computer that we cannot touch and see.
« Hardware is further classified into Input, Output and Storage devices.

o Software is classified as system software and application software.

Monitor, printer, speaker and projector are output devices.

Keyboard, mouse, microphone and web camera are input devices.

Hard drives, DVDs and USB drives are storage devices.
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A. Identify and name the following storage devices.

B. Fill in the blanks.

| R software is designed to run computer’s hardware and
provides a platform for applications.

2. CPUstands for .........co.......

3. can also work as photocopiers.

4. monitors consume 40 per cent less power than LCDs.

5. e, captures still pictures and motion videos.

C. Answer the following questions.

1. What are output devices? Explain with examples.

2. Explain system software and application software in detail.

3. Why are LED monitors more economical than LCD monitors?




4.  Explain any two storage devices.
5. How many types of printers are there? Explain.
D. Write down the full forms of the following abbreviations.
L ALU — et
2. DV D
3. CRT = .
4. LED  —
5. LD = e
E. Write ‘T’ for True statements and ‘F for False statements.
1. ALU stands for arithmetic and logic units. (]
2. There are 10 alphabet keys on a keyboard. (]
3. Laser and inkjet are the type of printers. ()
4.  Mouse and microphone are output devices. ()
5. CRT, LED and LCD are the types of monitors. (]
F. Tick (V') the correct answers.
1. Which is not hardware?
() a. Keyboard () b. Mouse
() c. Monitor () d. Microsoft Excel
2. Which is not a type of monitor screen?
() a. LED ()} b.LCD () c.CRT ()] d ALU
3. takes images generated by a computer and displays them
on a big screen.
() a. Projector [ ) b. Hard drive ) c¢. Monitor [ ) d.Light pen
OFY ¥ === = === = === X X === . Compuer} X 3N



Which is not a part of the CPU?
() a ALU [ Jb.CU ( JcCRT [ Jd.MU

This software fulfils a specific need or performs tasks.

() a. Application(_ ] b. System [ ) c. Speaker (] d.Hard Drive

@ Rl L

A. Whoam I?

1.

3.
4.
5.

[ am the most commonly used layout of the keyboard.

I am responsible for all the arithmetic and logical operations of the
computer.

CRT, LED and LCD are my types. .,
I can show images on the big screen. ...
ALU, CU and MU are my parts. e,

B. Identify the devices below and classify them as Input, Output and
Storage devices.




Team Work

Assess which of the following devices are present in your computer
lab. Use the lines below to write the names of the devices. Also, draw
pictures of the same.

Type of Mouse ..o,
Type of Printer = ...,
Type of MONItor : ....cooiiiiiiiiiiiiiiiiiiiiiiieeccee,

( ) 4 )
\ J \ J
e 2
. )
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CLASSIFICATION OF
COMPUTERS

At the end of this chapter, students will be able to:

+ Identify and explain the classification of computers based on size and
power.

+ Comprehend the use of different types of computers.

Look at the following pictures and number them out according to their sizes in
ascending order.

‘¥ ];%ﬂ(:her’s With the help of the above activity, inform students that the computers can be classified
2\ LR o) the basis of the size and power.
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;ﬁ'—-) L Hi! I am Peter. I will introduce you to another

F classification of computers. We have already read
about the hardware and software parts of the
computer in the last chapter. Now, we will classify
the computers on the basis of size and power.

é CLASSIFICATION OF COMPUTERS BASED ON SIZE

AND POWER
On the basis of size and power, computers are classified into the
following types:
1
lé! il
!
' ' ' ' '

MICRO COMPUTERS

These computers are minimal storage capacity
computers. They are commonly used in offices,
homes, shops etc. They are also referred to as
Personal Computers. For e.g. HP PC.

P

Micro Computers are further
divided into the following types:

..m o
&% @ Do You Know?

First mechanical computer was steam powered.

OEY ¥ === = === = === X X === . Compuwer3 X




x Computer-3 | == X X ﬁ X XEEE XX S XXX

Desktop Computer

Desktop computer is a personal computer
designed for regular use at a single location.
It has a monitor, keyboard and a mouse
attached with wires.

It also consists of UPS that helps us to work on the computer for
some time even when electricity is cut off.

Laptop Computer

A Laptop computer or notebook computer is
a highly portable computer that can be carried
easily in a briefcase. Its size is smaller than a
desktop computer and runs on a battery which
can be recharged.

Tablet Computer

Which type of computers are

A tablet computer is a small, flat computer | yere ot your home?

that is operated by touching the screen. We

can also write on it by using a pen called Stylus.
It is smaller than a regular laptop and larger than
a cell phone. It can be used for sending e-mails,
watching movies, listening to music, etc.

. )
REMEMBER IT! o

UPS stands for Uninterrupted Power Supply.
WORKSTATION COMPUTER

Workstation computers, also known as
desktop machines, are used for intensive
graphical applications. They have more
processor speed than personal computers.




MINI COMPUTERS

Mini computers are more expensive and more
powerful than microcomputers but smaller,
cheaper and less powerful than supercomputers.
It is a multi-threaded system. Mini computers
are used in industries and for scientific purposes.
An example of a mini-computer is PDP-8.

SUPERCOMPUTER

Supercomputers are the most powerful — §
digital computers. They are capable of
handling huge amounts of calculations
thatare beyond human capabilities. They
are usually thousands of times faster
than any other computer. They are used for weather forecasting,
space research and satellite control. An example of a supercomputer

is PARAM Brahma.

éCLASSIFICATION OFCOMPUTERS %ar if we were governed by
ON DATA PROCESSING SPEED supercomputerst

DIGITAL COMPUTERS

These computers are the most commonly
used. It calculates the numbers and does
logical operations. The main components
of digital computers are input, process and
output called the IPO cycle. They run on
electronic signs and binary systems 0 and 1.
Desktop, laptops and tablets are examples of
digital computers.
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ANALOG COMPUTERS

An analog computer is a computer which
is used to process continuously changing
data. They are used to measure and perform
arithmetic calculations of numbers, the
length of an object etc. They cannot store
statistics. An example ofan analog computer

is IBM SYSTEM / 7.

HYBRID COMPUTERS

Hybrid computers are complex computer
units built using both analog and digital
properties and united by a single control
system. These computers are used in
scientific applications, aeroplanes, ships,

and hospitals.
An example of a hybrid computer is HYDAC 2400.

‘ Can you name the first Indian supercomputer?

Let’s Recall !

Computers can be classified on the basis of size and power.

On the basis of size and power, computers are classified as micro computers,
mini computers, mainframe computers and supercomputers.

On the basis of data processing speed, computers are classified as digital
computers, analog computers and hybrid computers.

An example of Analog Computer is IBM system / 7.
Hybrid computers have the best features of Analog and Digital computers.

Computer-3
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A. Number the following computers in descending order based on their

sizes.
o Laptop computer :
e Mini computer :
o Supercomputer :
o Smartphone :
o Desktop computer :
B. Fill in the blanks.
| T computer is minimal in size and storage.
2. computers are used in scientific applications.
3. A computer is a flat, small computer that has a small
touchscreen display.
4 computers run on electronic signs and binary data.
5. HYDAC 2400 is an example of .................... computer.

C. Answer the following questions.

1. Explain the classification of computers on the basis of size and power

with the help of a diagram.




Explain Mini computers with examples.

--------------------------------------------------------------------------------------------------------------------

Write ‘T’ for True statements and ‘F’ for False statements.

1.

A

Supercomputers can handle calculations that are beyond

human capabilities.

Analog computers can measure the length of an object.
PDP-8 is a supercomputer.
Hybrid computer systems have multiple control systems.

Hybrid computers contain the best features of both analog

and digital computers.

E. Tick (V') the correct answers.

)¢

1. Computers are classified on the basis of sizeand ....................
() a. Speed () b. Power () c. Material
2. computers can be carried easily in a briefcase.
() a. Workstation [ ) b. Super () c. Laptop
Computer-3 =YX == = === = === X XuN




3.

5.

1.
2.
3.

Workstations are mostly used for

() a. Weather forecasting [ ] b. Intensive Graphical Applications

() c. Making a call

.................... computers are also referred to as personal computer.

() a. Micro () b. Mini () c. Super

Tablets and Laptops are the examples of .................... computer.

() a. Digital () b. Analog () c. Hybrid

F. Match the devices with their characteristics.

UPS a. multi-threaded system.

Tablet b. are used for weather forecasting.

Workstations c. canmake computer work without
electricity.

Supercomputers d. are also known as desktop
machines.

Mini computers e. works with a pen called stylus.

@ Critical Thinking

A. Mrs Peter owns a chain of schools. Now, she is thinking to open a

school in a rural area. Also, she wants to install 15 computers in her

school for the computer lab. Suggest to her the type of computer she

should buy for the new school.




B. Follow the instruction and colour the following computers on the <
basis of data processing speed.

@ Hybrid computer

Team Work

@ Digital Computer

IBM
System /

7

@ Analog Computer

Find about the first mechanical computer and paste its picture below.

[

-

~N

B X Computer-3




At the end of this chapter, students will be able to:
+ Describe an operating system.

+ Learn and write the features of windows 10.

+ Explain the taskbar and windows accessories.

+ Change the desktop appearance and screensaver.

Apprise students that as we always need a clear set of instructions to complete a particular
task, similarly computer also needs instructions to work with accuracy.
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A Hello friends! I am Peter. As we need a proper
set of instructions to complete the task with
accuracy, in the same way, for computers to
work with accuracy, they have a special set of
programs known as an Operating System.

&} AN OPERATING SYSTEM

A computer can complete various tasks simultaneously with complete

accuracy. Have you ever thought about how a computer can do this?

Ability of a computer to carry out all of its functions depends on a
unique set of programs. These special sets of programs are known as
the Operating System (OS). An operating system is a software that
helps us to work on a computer system. It is the most important part
of the computer system. For e.g. Linux, GM-NAA, MAC, Android

and Microsoft windows.

Microsoft Windows is the most

.‘ %
£% @ Do You Know?

Commonl}’ used OPeI' atlng SYStem GM-NAA was the first operating system

used for real work.

developed by Microsoft Corporation.
It is a Graphical User Interface-based operating system. There are
various versions of Windows namely Windows XP, Windows 7,
Windows 10 etc.
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Let us study in detail about Windows 10.

&} FEATURES OF WINDOWS 10

» In Windows 10, multiple users can work on one computer system
at the same time.

» The search tool of Windows 10 is called Cortana, which lets
us search for any information on the system or on the internet
directly.

» It also provides the feature of downloading free and paid apps
from an application called the Microsoft Store.

» We can open numerous desktops simultaneously by using the
task view button.

& pARTS OF WINDOWS 10
Desktop

It is the first screen which appears on the monitor whenever a
computer system is turned on. We can use our computer for work

Figure 3.1: Current Desktop

OEY ¥ === = === = === X X === . Computer} X




Icons

Icons are the small stamp-like pictures on the screen that represents
a file, a folder or a program. An icon can be opened by double-
clicking on it. »

= L I
Examples: b H
- "

Icon of recycle bin Icon of PC
Apps
Apps are small programs that = —
provide quick information. ;==
These are the softwares that -
allow you to perform specific
tasks. Any app can be searched

by typing its name in Cortana.

Start Button o

. '
«H| B B! B! B!
i | I | I i

Figure 3.2: Desktop App

Start Button is the most widely used #;

button on the Windows desktop. | Have you downloaded any app ever?
The Start button in Windows 10
is a small button that displays the Windows logo and -

is always displayed at the left end of the taskbar. When
a start button is clicked, two panels open side by side.
One panel displays a list of apps arranged in alphabetical
order, and the other displays the latest updates.

Recycle Bin

It temporarily stores the v
deleted items from the oo
computer before they are "4
permanently deleted.

Discuss the difference between a garbage
bin and a recycle bin in computers.
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Windows Taskbar

The long horizontal bar which is present at the bottom of the desktop
is called Taskbar. Various parts of the taskbar are the start button,
middle section, quick launch toolbar and system tray.

The start button is found on the left side of the taskbar. Next to the
start button is the search box called Cortana. Next to Cortana is the
middle section. It shows programs and files we have opened and
allows us to switch between them quickly. These programs can be
opened with a single click.The system tray shows the date, time and
various other notifications.

Start button Open and pinned programmes Time and date

O o s Y Ny N T

Cortana, Run and Search Figure 3.3: Windows Taskbar Notification Area

& ACCESSORIES OF WINDOWS 10

The windows operating system comes with some useful tools called
accessories. It is available in all versions of Windows.

Steps to open Accessories
o Click on the start H button.
o Click on All Apps icon on the toolbar.

e Choose Windows Accessories.
Let us discuss some essential Windows Accessories. 0

Calculator

The calculator is an app that performs arithmetic
calculations such as add, subtract and scientific
calculations.

Figure 3.4: Calculator App
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Notepad

Notepad is a basic text editing tool
developed by Microsoft Windows. It
allows us to create, edit and print a
document. We can also save a file in the

Notepad app.

Windows Media Player R N i -
Windows Media Player is an application _;%_ _- = A= -
that allows us to play audio, video files " | p/= {J)= o
and view images. J- M-

Other accessories are Paint, Wordpad O -

and many more. — Figure 3.6: Windows Media Player

REMEMBER IT! &

Window Media player allows you to create your own playlist.

é ALTERING THE SCREEN APPEARANCE IN WINDOWS

If you have noticed, you would have found that all the applications and
data on a computer screen look in a particular way. This is because of
the default settings of Windows. We can change the default settings.
It can be done either by changing the wallpaper or screensaver or

both.
Changing the Wallpaper

Wallpaper is the background picture that appears on the desktop
screen. It is also known as desktop wallpaper.
We can change the desktop wallpaper using the following steps.

Steps:

1. Right-click on empty space on the desktop. A shortcut menu will
appear.

X Computer3 | e W ¥ kP
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2. Click personalise. This option is at the bottom of the drop-down
menu.

3. Click the box beneath the ‘Background’ Select the desired picture.

Setting the Screen Saver ’%‘T Do You Know?

There are some pre-installed wallpapers on
the computer system.

The Screen Saver is a software

program that becomes activated after
the computer remains inactive for a specified amount of time.

We can change the Screen Saver using the following steps.

Steps:
1. Right-click on empty space on the desktop.

2. A shortcut menu will open.

3. Click the personalise option. This option is at the bottom of the
drop-down menu.

4. Select the Screen Saver option.

5. Click on the desired Screen Saver and click on the Apply option.

- s Kids’ 1Q

Find and name the OPERATING SYSTEM used:
a. On your school computer : ...
b. At your Father’s Office e

L < At your home computer — : ...

! Let’s Recall

An Operating System is a software thatacts as an interface between the computer
and us.

o There are several features of Windows 10.

o The first screen that appears on a computer system is called the Desktop.

o Taskbar is present at the bottom of the desktop.

o Icons are small stamp-like pictures on the screen that represent programs.

« We can change the screen appearance in windows by changing its wallpaper
and screen saver.
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B. Fill in the blanks.

1. Windowsisa .............. User Interface program.

2.  From the Microsoft Store, we can download free and ....................
Apps.

3. s is the long horizontal taskbar present at the bottom of
the desktop.

4. Altering the screen appearance in windows includes changing
.................... and ...

5. LINUX s an example of ....................
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C. Answer the following questions.

1.  What is an Operating System? Explain with examples.

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

D. Write ‘T’ for True statements and ‘F’ for False statements.
1. Taskbar is present at the upper part of the desktop. (]
2. We cannot change the screen appearance in Windows 10. ()
3.  Windows media player is used to view images only. (]
4. Icons are stamp-like pictures. ()
; O

Linux is an operating system.
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E. Match the following. <
1. LINUX a. are searched in cortona.
2. Calculator b. is an operating system.
3. System tray c. can do addition and subtraction.
4. Middle section d. shows the date and time.
5. Apps e. isnextto Cortana.

@ Critical Thinking

A. Harsh deleted a file two days ago. Now, he wants to retrieve that file.
Which application or icon will help him to do this task?

-----------------------------------------------------------------------------------------------------------------------------

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

B. Complete the names of the following Operating Systems.

. _ A__
2. IN
3. G_-N

Team Work

Search for information on ‘Forests’ using the Windows Search Tool -
Cortana. Write 5 lines on the topic in given space below.

.............................................................................................................................
.............................................................................................................................
.............................................................................................................................
.............................................................................................................................
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TEXT EDITING IN
MICROSOFT WORD 2016

At the end of this chapter, students will be able to:

+ Understand different components of Word.

+ Know about Undo and Redo Commands.

+ Recognise various methods to select the text for editing.

Observe the logo of the following word processor and write five things you know
about it.

Apprise students that MS word is a potent word processor. Take students to the computer
lab and tell students to type 5 lines about their favourite festival. Make them save the

file too.
=== X X == _ Compuer} X SN
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87 k Hello friends! You studied MS \
' - WORD 2016 in the previous

class. Now, lets discover more
features of MS WORD.

& THE BASICS OF MS WORD

One of the most widely used word processors produced
by Microsoft Corporation is Microsoft Word. We can
quickly and conveniently create, read, change, and
share files. It comes in the Word 2010, Word 2013,
Word 2016 and Word 2019 versions.

The following are the uses of MS Word 2016.

» It allows you to copy and move the text from one location to
another.

» It permits you to create letters, resumes and notices in an orderly
manner.

» It lets you edit the text after typing.

» It enables you to preview the text before printing.

é VARIOUS COMPONENTS OF MS WORD
Quick Access Toolbar

The Quick Access Toolbar is a command line that appears on the
top-left corner of the MS Word window. From this toolbar, we can

x Computer-3 | == X X ﬁ X XEEE XX S XXX




quickly perform some tasks like Save
and Undo/Redo. This toolbar can be

..m ?
<% @ Do You Know?

) . To create a shortcut of Word 2016, drag
customised to our needs and gives | itsicon to the Desktop.

access to frequently used features and
functions such as quick print, open recent files etc.

Quick Access Tabs Title Bar Ribbon
Toolbar

Document Area

Status Bar zoom slider

Figure 4.1: MS Word Components

Title Bar

The Title bar is next to the quick access toolbar. It shows the name
of the document which is opened. By default, the name of any new
Word document is Documentl.

Tabs

The buttons located below the quick access toolbar and the title bar
are tabs. The most widely used tabs are the Home tab, Insert tab,
design tab, Layout tab, mailings tab and Review tab. The Home tab

=== X X === . Compuer3 X
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is the default tab in Microsoft Word. It has five groups of related
commands; Clipboard, Font, Paragraph, Styles and Editing.

Ribbon

It is below the tab buttons. All the seven tabs in the ribbon have a
specific group of related commands. The image given below shows
the commands under the Insert tab. Several functions such as adding
shapes, text box, clipart, cover page, header and footer etc., can be
inserted into a document using these commands.

B T T W a8 | P ) HE4q NS
Figure 4.2: Ribbon

Document Area

The document area is the blank or white section of a MS Word that
allows the user to create content. When a document is opened, you
can begin typing and your text appears in the document. When a
saved document is opened, the text is already present and we can
edit the text.

Status Bar

The status bar is the area at the bottom of the Word window that
indicates information about the current document. It displays
information about what page you are on, your line number and your
character number on the line. It also shows the total number of words
in the document as well as the language used in the text.

Zoom Slider

It is in the lower right corner of MS Word. It is available for zooming




in and out of documents quickly and easily. The * + ° sign is clicked
to zoom in on the document, and the * - ° sign is clicked to zoom out
of the document.

= B - i +  100%

Figure 4.3: Zoom Slider
& HoW TO TYPE IN MS WORD

Whai points do you keep in
mind while writing?

Points to remember while typing.

1. Leave one space between words.
2. Enter to be pressed only after completing a line or a paragraph.

3. Press the shift key and the alphabet key to type capital letters.
Alternatively, we can turn on the Caps Lock key, type the letter
and then press the key once again to turn it off.

4. Always remember to save your file after some time.

Selecting Text

If we want to make changes in the text we type, such as text style,
colour, size, alignment etc., then we need to select the line, word, or
paragraph we want to edit.

Selecting a Word

To select a single word, quickly double-click

that word. Alternatively, place the cursor at Computer Class

the beginning and drag the mouse pointer

over the word. a T ——

Figure 4.4: Selecting a Word
Selecting Line

A line in a document can be selected in following ways.

To select a line of text, place your cursor at the start of the line,

IFY ¥ === = === = ={JJ== X X == . Compuer3 X




and press Shift + down arrow or place Fr—

the cursor at the beginning of the line
and drag the pointer over the line.

+ Set the mouse pointer at the beginning, _
of a line then click the left mouse button.  Figure 4.5: Selecting a Line

Selecting a Paragraph H e e e R R b 1

We can select a paragraph in a

document by clicking on a text T A T T .
section three times with the left

mouse button.

Selecting the Entire Document & ——

Figure 4.6: Selecting a Paragraph
The whole document can be selected by placing the cursor at the

initial of the document and pressing Ctrl + A or by pressing the Shift
+ Ctrl + End key combination.

&} uNDO AND REDO COMMANDS
Undo Actions

Undo erases the last change done to the
document, reverting it to an older state.

<+ Click Undo on the Quick Access
toolbar.

" ¥ Format Painter

< If you want to undo multiple steps,
press Undo (or CTRL+Z) repeatedly.

Figure 4.7: Undo Action

®

Redo Actions What do you do when you make a

mistake while writing with a pen?

The redo command restores what we just
did.
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<+ If you want to redo an action you
have undone, click Redo on the Quick
Access Toolbar.

Deleting the text B .
Past

A line, word or a paragraph in the docu- " & FormatPainter | B

ment can be deleted in the following ways. Figure 4.8: Redo Action

< Press the delete key while the cursor is positioned to the left of
the letter or character you want to remove. The right-side text is
deleted by using the Delete key.

+ Select the word you want to delete, then press the delete key.

+ If you want to delete a paragraph, select the paragraph by clicking
thrice and pressing the delete key:.

i

S A
REMEMBER IT! b

Press Ctrl + Delete and Ctrl + Backspace key combinations to delete one word to

the right or left respectively.

L Kids’ 1Q

Raman was asked by his teacher to write paragraphs on ‘Plants. However, he
wrote some irrelevant information as well. Now, the teacher asked him to delete
that. How will you help him to do this?

! Let’s Recall

Microsoft Word is one of the most popular word processors developed by
Microsoft Corporation.

e A Word Processor allows us to edit, insert and format the text.

« MS Word components comprise of Quick Access Toolbar, Tabs, Ribbons,
Document Area, Zoom slider, Status bar, etc.

« Undo and Redo command reverses our last action and repeats our last action,
respectively.
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: ias L e
A. Fill in the blanks.
1. Microsoft Word is developed by .......................
2. Wecan ....ccoeeinncnn the text before printing.
3. The Title baris nexttothe .............cccocooeee...
4. The Quick Access toolbarisa .......cccoecvvvveveeennn.. line.
5. Thehometabisthe ........................... tab in Microsoft word.

B. Answer the following questions.
1. What is the use of the Title Bar?

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

5.  Which component of MS Word allows you to zoom in or out of the
document?

--------------------------------------------------------------------------------------------------------------------




C. Write ‘T’ for True statements and ‘F’ for False statements.

4.
5.

A zoom slider is the blank or white section of a MS word.
Mailings Tab is one of the most widely used tabs.

We can quickly perform some tasks like Redo from the Quick
Acces toolbar.

MS Word does not let you edit the text after typing.

Jog 00

By default, the name of any new word document is New.

D. Match the following.

1.
2.
3.
4.

Title Bar a. Blank Section

Ribbon b. Name of the document
Document Area c. Shift key + Alphabet key
Capital Letters d. Below the tab buttons

E. Label the components of the MS word.
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A. Neha has typed a letter in MS word to be submitted to her teacher.
Her sister came, and by mistake, she deleted the entire letter. Now,

which command should she use to get back the letter?

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo
ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

B. Find out the Tab name available on the MS word window in the grid
given below:

T/ L|A|Y|O|U/|T]|TI

E|M|N|E|Q|F| A |N

M|A|T|L|T1|N|G|S

O|S|D|P|B|N|C|E

H| X|W|E|I1|V]|E]|R

D/ E|S| I |G|N|E|T
Team Work

Write a paragraph in MS Word on “My favourite Toy”. Save your
document with the name of your Toy. Take a print out of it and paste
it in your notebook.




FORMATTING IN MS WORD

At the end of this chapter, students will be able to:

+ Change the Font colour, style and font size of the text.

+ Apply text in alignment.

+ Add borders and shading effects to improve the appearance of the text.
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Ask the students about the features of MS Word 2016. Encourage them to remember and
revise what they learnt in the previous chapter: MS Word Components, Typing in MS
Word, Undo and Redo Commands and much more.
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87 L Hello friends! You already know how editing
: features of MS Word 2016 work. Let us learn
about a few formatting features that help our
document look presentable.

As we read in the previous chapter, Microsoft Word, developed by
Microsoft Corporation, is one of the most popular word processors

used worldwide. It allows us to create, edit, read and share files easily.

To make the document look presentable, we may change the
appearance. For it, we need to format the text, which means making

changes in the text and its appearance to make it look pleasing.

Features oftered by MS Word to format the text are as follows.

A

< Font style, size and colour

-‘ 2
<% @« Do You Know?

MS Word was first released on October 25,
1983, under the name Multi-Tool Word.

Text case and alignment

A

< Border and shading effect

& ront

A font refers to the size, design, colour and style of typed characters

within a document. To add variation to a document, we can use
different fonts, such as separate font styles for the heading and the
body. The Home Tab contains the Font settings. Following are the

options which are included in it:




danidny Webve Help ':;:' [l e what yo

i =

Paste - e
¥ Format Painter B I U sbe X, M ! ¢

Chpbnant 5] Fomi

Figure 5.1: Font Settings

Paracyraph

We can press the Ctrl + Shift + F key combinations to open the Font
dialogue box.

Font Size

Font size increases or decreases the size of the characters. The size is
measured in points from 8 to 72. By default, the font size is 11.

Follow the given steps to change the font size of the text.

Steps :
1. Select the text you want to modify.

2. On the Home tab, click the drop-down arrow next to the Font
size box.

3. Select the desired font size.

4. 'The font size will change in the document.

Which font size would you suggest
for class 3 students?

COmpUter s

Figure 5.2: Font Size
Font Colour

MS Word allows you to change the font colour of your text. If you
want to emphasise a particular word or phrase, you can change its
font colour. The default font colour in MS Word is black.

={D== X X === . Compuer3 X
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Follow the given steps to change the font colour of the text.

Steps :

1. Select the text whose colour you want to change.

2. On the Home tab, click the Font

f H@}
Color drOP'dOWH arrow. The Font Which is your favourite colour? Why?
Color menu appears.

3. With the help of the mouse, select the font colour you want to
use. The font colour will change for the selected text.

4. Your colour choices are not limited to the drop-down menu that
appears. Select More Colors at the bottom of the menu to access the
Colors dialogue box. Choose the colour you want, then click OK.

— i

Stamderad Caprboem

s '= 3 Lot Cancel

;Illlllill
an: cassam.Omputer class

Figure 5.3: Font Color

Font Style

We can also modify the font style. In MS Word, there are many
different font styles to choose from. The font style is set to Calibri by
default.

Follow the given steps to change the font style of the text.

B = Computer3 | e W ¥ el
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SteBS: arial 11 - & A | fa- A

Them= Font=

1. Select the text whose font style you e _—
need to modity. Calibr ¥

Al Forts

H oA

2. On the Home tab, click the drop-down | aisemiay
arrow next to the Font box. A menu of | 2™

AHal Blatk
font styles will appear. Arial Nairow
Arial Roundad MT Bold
3. Select the font style you want to use. Az ber
Bahnschrift

Eahnzchrift Condensed
Sansckr E Ligbt

4. 'The font will change in the selected text.

e

. i Btz il izl Bevel2nser:
ReEMEMBER IT! ¥ Gahnzchri= Light ZemiCentenzed
SO OUPUIIOURUILA U UV O ) IL:.-%

It is estimated that MS Word is running on more Figure 5.4: Font Style

than a billion devices worldwide.

Making the text Bold, Italics and Underlined

You may highlight keywords or phrases using the Bold, Italic and
Underlined commands.

Follow the given steps to make the text Bold, Italics or Underlined.

Steps:
1. Select the text you want to modify. g ="

2. On the Home tab, click the e T ety il
Bold (B), Italic (I), or Underline - i
(U) command in the Font group. Figure 5.5: Text making Italics
Consider the example; click

Italics.
3. The selected text will be modified in the document.

Bold: Ctrl + B keys Italics: Ctrl + I keys
Underline: Ctrl + U keys
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Text Alignment

The placement of the text within the margin of a page is referred to
as alignment.

There are four alignments as follows.

~ R ~ A e R e R
- J - J - J - J
Left align Center align Right align Justify align
Left Alignment

It places the text towards the left margin. In Microsoft Word, the text
is left-aligned by default.

Shortcut key: Ctrl + L keys
Right Alignment

It allows the text to align with the right margin. It is frequently used
to mention the date in a document.

Shortcut key: Ctrl + R keys

Center Alignment

It aligns the text in the centre of the left and right margins. It is mainly
used with titles and headings.

Shortcut key: Ctrl + E keys
Justify Alignment

It places the text evenly distributed between the left and right margins.
It is significantly used for designing books and newspaper content.

Shortcut key: Ctrl + ] keys
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How should text alignment be used?

Step 1: Select the text.

Step 2: Select the desired alignment button [:J [:] [:J [%j
on the Home tab in the Paragraph group.

Step 3: 'The selected text will be aligned.

Change Case

To change the appearance of the text, the change case option is used.
The change case menu offers five options:

Sentence case: The first :
letter of each sentence is
capitalised. o g o s b sk g st s

hr b e el i eard b g e Tl apsess awr dr i mEEILRE

Tl CRARAREL LR DFTS0 I W 70 D0l T TR APPTARMARLT T e

Uppercase: All the letters of  moweom o st nemitmmstns oo e
the text are capitalised.

Lowercase: Text is changed
from UPPERCASE to Figure 5.6: Change Case
lowercase.

Capitalise Each Word: The first letter of each word is capitalised.

Toggle Case: Case of each an every letter in the sentence is reversed.
It will convert a letter written in uppercase to lowercase and vice-
versa.

Borders and Shading

To improve the appearance of the text, borders and shading effects
can also be added.

Follow the giving steps to apply Borders and Shading.

Steps :
1. Select the paragraph(s) to which you want to add shading and

borders.

=== ¥ X === . Compuer3 X
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2. Click the drop-down arrow next to border button and click
on the Border and shading option.

3. Under the setting section, click on the box option.

4. Select the line style from

the style section and line o v T
colour from the colour ﬁ o =0 | " smsmia
drop-down list. E P [—

5. Choose the line width S e
from the width drop-down 5 . L
list. E . .

6. In apply section, select the I e —
paragraph option. Click =1
OK, and the border appears Figure 5.7: Border and Shading

around the text.

- 2 Kids’ 1Q

Rahul wants to write a letter to inform his class teacher that he will not be able
to attend school because he is ill. Which ‘Case’ option should he use to write the
content of the letter?

! Let’s Recall !

« Formatting means changing the text appearance to make it look pleasing.

o A font refers to the size, design, colour and style of typed characters within a
document.

 'The positioning of text on a page is referred to as text alignment.
« Change case allows changing the text appearance case.

o The change case options are Sentence case, Lowercase, Uppercase, Capitalise
Each Word and Toggle case.
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A. Fill in the blanks.

Lo e, means changing the text appearance to make it
look pleasing.

2. The ., tab contains the font settings.

3. We can press the Ctrl + shift + F key combinations to open the
............................ dialogue box.

4. 'The default font style in MS Word is ...........cccooeeine,

5 alignment evenly distributes the text between the

left and right margins.

B. Answer the following questions.

1.  What are the features offered by MS Word to format the text?

them.




x Computer-3

5. Write the steps to make the text Bold.

C. Write ‘T’ for True statements and ‘F’ for False statements.
1. A font is often measured in pixels.

Italic is used to tilt the text.

Sentence case makes the first letter of each sentence capital.

A

The positioning of the text on a page is referred to as Text
alignment.

[
[
Centre alignment is used significantly for designing books. (]
L
[

D. Match the following.

1. Ctrl + R keys [

—

2. Ctrl + B keys

3. Ctrl + E keys {

4. Ctrl + I keys

5. Ctrl + L keys

I | & {1l

l‘

|
A
||
%
I
il

I
ni
]

]




E. Tick (V') the correct answer.
1. By default, text in MS Word is ................... aligned.
() a.Right () b.Centre [ ] c. Left () d. Justify

2. In which group ‘Bold, Italics and Underlined’ commands are there?
() a. Font () b.Home () c. Insert () d. View
3. Which command do we press to tilt the text?

() a Right [ ] b.Underline [ ) c. Italics () d. Bold

4. Ctrl +U keys combination is the shortcut for .................... the text.
() a. Leftalign () b. Tilting () c.Underling ( ) d. Colouring
50 alignment is frequently used for mentioning the date in

the document.

a.Centre [ ) b.Justify [ ) c Left () d. Right

‘ Critical Thinking

A. Number the following steps in order to change the font style of the
selected text:

o The font will change in the selected text. ()

o On the Home tab, click the drop-down arrow next to the Font box.
A menu of font styles will appear. ]

o  Select the text whose font style you need to modify. [ |
o Select the font style you want to use. ()
B. A book publishing house wants to align the text of the books. Help

the team by suggesting a suitable option which will complete their
task.




Team Work

Create a birthday invite for your friends in MS WORD 2016. Apply
all the editing and formatting skills you have learned.

# )
BIRTHDAY INVITE

Dear Ankit,

You are cordially invited to celebrate my birthday on Friday,
29th July at 8:00 p.m.

Address : Sagar Apartment,

L 81, Moti Nagar Road
Contact Number : XXXX7352XX
PMIC

Your Name

"
Q)
2
]
|
%
I
N‘
]
ui
]
|




At the end of this chapter, students will be able to:
+ Utilise various drawing tools to make drawings in Paint 3D.
+ Differentiate between 2D and 3D shapes.

USING PAINT 3D

Apprise students that 2-D shapes are plane or flat shapes, whereas 3-D shapes are solid
figures that can be viewed from 3 directions: length, width and height. Also, show them
real objects such as Rubic cubes, balls, erasers, books etc.

I
I
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87 L Hello friends! In this chapter
' let us learn about Paint 3D,
a brand-new and innovative
drawing programme.

All previous versions of Windows came with basic paint software
from Microsoft. A new Paint version, Paint 3D, is included in the
latest version of Windows 10. It is a free application with the addition
of creating and editing 3D images in a Paint program.

The application is comprehensive yet easy to use. By merging 2D
and 3D tools simply, it aids us in producing creative projects that are
both entertaining and professional. Anybody can use Paint 3D. Its
user-friendly interface makes it simpler ta edit already-created 3D

models and produce new ones. @

Look around and tell the names of
é STARTING PAINT 3D APP 2D and 3D shapes present in your
Follow the given steps to start the Paint classroom
3D app.

Steps:
1. Click on the start button.

2. You can choose the Paint
3D option from the menu
or type Paint 3D in the
search box.

3. The paint 3D window will
open. 1
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&} PAINT 3D INTERFACE

1 2 4 6

Figure 6.2: Paint 3D Interface

The Paint 3D window has the following elements.

1. Menu: When you click on the expanded menu button, it opens a
variety of list options such as New, save, save as and many more
to perform multiple functions.

2. Brushes: Brushes tool has difterent brush 2w
types, which are used to draw lines in """

: : P S AT
various styles. It can be used to paint on
both 2D and 3D surfaces. ;IHD - -

3. 2D Shapes: This option is used to draw & < ¢ N o
2D shapes. This tool has many readymade & & < 51 4+
shapes such as line, rectangle, stars, arrows, & & © 2 «
triangle and many more. S =

Figure 6.3: 2D Shapes Tools
OEY ¥ === = === = =fjf== X X === . Compuer3 X
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4. 3D Shapes: This option allows 2 & &

to draw 3D shapes, such as cube, i
cuboid, cat, woman, and many © @ A A
other 3D shapes.
B0 0%
o 30 mcdols
v+ 8 8 ® 0 &
S H % - Figure 6.4: 3D Shapes
ToeE 5. Stickers: With this tool, we can select
R images from a ready-made image
Db collection and apply them as stickers
g to our designs. The opacity of the

chosen and applied sticker can also

LR be changed.
Figure 6.5: Stickers 20 et

7
6. Text Tool: This tool allows to add 2D | -
text or 3D text options in the drawings. = 1
=
..‘ ‘@ - Figure 6.6: Text Tools

a“f‘*é

- , 7. 3D Library:Itisacollection of thousands
s | 1"""" of free 3D models divided into several

Figure 6.7: 3D lerary categories.
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8. Canvas: The canvas of the 3D Paint window is the area where
we can draw different drawings.

&3 BRUSHES IN PAINT 3D

In Paint 3D, brushes enable us to produce
stunning and distinctive designs. When the ¢ A
iA

Mlarker

Brushes tool is selected, ten brush options A

appear in the right-side panel. We can adjust

or change thickness, opacity, material and

colour of the brush. 4

Step 1: Select a brush, click the left mouse Qo
button at a starting point, and then i
drag the mouse to create a line. Figure 6.8: Brushes in Paint 3D

Step 2: Use several brushes in various ways. Try out various options
for colours and thickness.

& DRAWING 2D SHAPES

We can design excellent shapes with Paint 3D’s extensive library of
2D shapes. It also helps to create precise shapes using the line and
curve tools.

Follow the given steps to draw 2D Shapes in Paint 3D.
Steps:
1. Click on the 2D shapes option. °

2. From the list of 2D Shapes, O
select the square tool.

3. Place the mouse cursor on the

canvas. a o
Figure 6.9: Drawing 2D Shapes
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4. When the mouse pointer turns into a ‘+ sign, drag it to make a
square.

5. Fill the colour to the square using the Fill %

7N
Which all shapes are there in
group option. the 2D Shapes library?

&8 DRAWING 3D SHAPES o
evBeR 11!

Search any 3D object by typing
its name in the search box.

This 3D shapes library option contains
basic 3D doodles, 3D objects and 3D
models to start drawing. 3D Doodle tool lets you draw tabular,

rounded and sharp-edged shapes. 3D objects help you select the pre-
defined 3D shapes like Cube, spheres, and many more. 3D models
panel contains 3D models like Man, dogs, and fish.

Follow the given steps to draw 3D Shapes in Paint 3D.

Steps:
1. Select the 3D shapes option.

2. Click on the Tube tool from the given 3D shapes.

3. Place the mouse cursor on

T ey . s s geg -
the canvas. e :

4. When the mouse pointer .
turns into a ‘+’ sign, drag it T i Tyt

B B® ¥

to draw a tube.

5. Fill the colour in the tube
. . . [ = | Y
using the Edit Colour option. Figure 6.10: Drawing 3D Shapes

I ==Y X == = === = =

I
I




& oPENING A PROJECT

To open a previously saved file or project, click on the open option
in the Menu tab.

Follow the given steps to open a saved project.

Steps:

1. Click expand menu button.
2. Click on the open option.
3. 'The open window will display a list of saved projects.
4. Select the desired saved projects from the list.
5. Click the Open button.

o> i

e ® | 4O

Figure 6.11: Opening a project
SAVING A PROJECT
Follow the given steps to save a ?;T Do You Know?
dr awing in Paint 3D. You can save your drawing by pressing
Ctrl + S key combination.

Steps:

1. Click Expand menu button.

=== X X === . Compuer3 X
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2. Select the Save As option.
3. Type a name for your project.

4. Click the Save option.

Figure 6.12: Saving a Project

(s Kids’ 1IQ

In paint 3D, Harshit created a science diagram. He is not able to draw a few
pictures in it. Think about the options you can provide him to get them from the
readymade picture gallery.

& Let’s Recall

« Paint 3D is a free application with the addition of creating and editing 3D
images in a Paint program.

o The Paint 3D window has elements like Menu, Brushes, 2D shapes, 3D shapes,
Stickers, Text tool, 3D Library and canvas.

3D shapes panel contains basic 3D doodles, 3D objects and 3D models to start
drawing.

o In Paint 3D, brushes enable us to produce stunning and distinctive designs.

o Text Tool allows adding 2D or 3D text options in drawings.
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)Ey Upskill Your Intelligence v—g

. Fill in the blanks.

1. To open a saved project, click on the ........................... tab.

2. The ., of the chosen and applied sticker can be changed.

K tool has many readymade shapes such as lines,
rectangle and triangle.

4o tool allows to add 2D or 3D text in the drawings.

5 is the area where we can draw different drawings.

. Answer the following questions.

1. Whatis Paint 3D?

. Write ‘T’ for True statements and ‘F’ for False statements.

Paint 3D is a paid application. (]
Brushes tool has different brush types. D

The Menu tab contains various options such as New, save,
save as, and many more.

4. 2D shapes option is used to draw a circle, star and rectangle. (]

5. To draw a 3D shape, the mouse pointer turns into a ‘+’ sign. (]

B X X
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D. Match the following.

1. 2D shapes

2. 3D shapes

3. Brushes

4. Text




@ Rl L

A. Look at the shapes and segregate them in the columns below.

2D SHAPES 3D SHAPES

B. Anushka has created a 3D drawing in Paint 3D. She does not know
how to save the drawing she has made. Suggest the option to her to
fulfil this task.

Team Work

Pair up with your partners.
Draw a Christmas tree in Paint
3D using different 3D shapes.
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At the end of this chapter, students will be able to:

+ Start the Scratch application.

+ Know different components of Scratch 3.0 window.
+ Draw shapes in Scratch.

Decode the colour bar and write the answer in the given spaces:

Codes:

A N L

U E
1 Pink
2 Black
3 Purple
4 Yellow G
5 Green
6 Black
7 Yellow G
8 Brown

Apprise students that we use language to communicate with our friends and family, in
the same way, computers also use the particular language to understand our instructions

Q\J’ ote:
which are called as programming languages.

‘¥ Teacher’s
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;i‘i-’ b \[ Hello friends! Do you know the name \

of the language which computer
understands? What would you do to
make the computer understand your
instructions?

While communicating with other people, we always keep in mind
that he/she should know the language we are using to communicate.
How do we communicate with a computer? Any commands we may
give to a computer in English or any other language are unknown to it.
It requires a different set of languages to understand the instructions.
The languages the computer understands are called programming
languages, and Scratch is one of them.

For beginners, Scratch is an excellent visual programming language.
We can create interactive narratives, games and animations. We can
give instructions to the computer using visual blocks.

Let us now discover some fascinating [€== i [R'(TTH (T
features of Scratch. A program in scratch is saved as a project.

& FEATURES OF SCRATCH
< Scratch is freely available on the web.

< The cartoon mascot of Scratch is a cat.

< For a story, we can design our characters.

< It can run well on various operating systems, including Windows,
Linux and Mac OS.
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< Our favourite characters can be used to create games and
animations.

+ We can share our stories and games made using scratch on the
web.

&3 LET US START SCRATCH 3.0

2

Follow the given steps to run
the Scratch.

Steps :
1. Click on the start button.

2. Click the Scratch Application
1 Figure 7.1: Starting Scratch 3.0

and its window opens.

e .
o
= —] o
" o o
2
: “o- © 0
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= — ] =
=~ @] =
S
=
= LS O 0
Figure 7.2: Scratch Window
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&3 COMPONENTS OF SCRATCH 3.0

The following are the components of the Scratch window.

1.
2.

Title Bar - The title of the project you made is shown here.

Menu Bar - The menu bar has a variety of menus and icons,

including File, Edit, Tutorials etc. 3
REMEMBER IT! bé

Script Area - Script area is where Ascriptisalso calledaprogram.
you add blocks to write the script
for a sprite.

Sprite - It is a tiny graphic that roams on the stage independently
By including blocks to the script, we can control the sprite. A
new project begins by default with the cat sprite.

Stage Area - The area where sprite moves independently.

New Sprite buttons - We can create new %2 Let me Answer

sprites using these. What s the other name
for a script?
Menu Bar Title Bar

0 .
- Sprite
o BCE
L3
ﬂ Blocks Menu
o m:l Stage Area
Script Area
=
a
m Block Palette
L] = 1 -
= = 0
" Backdro
m == Icon; P
E = Add Extension New Sprite Buttons ﬁ. .@
Figure 7.3: Scrach Window Components
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7. Blocks Palette - Blocks for programming are found here. Drag
the blocks to the script area from the block palette.

8. Add Extension button - Use the Scratch extension button to
add blocks like the music block and pen block that have more
functionality.

&} DRAWING SHAPES IN SCRATCH

Scratch 3.0 allows you to draw various shapes by stacking blocks one
over another.

Follow the given steps to draw a circle in Scratch 3.0.

Steps:

1. Click on the ‘Add
Extensions’ button. The

pen blocks will then
be added to the blocks

menu. m

2. Choose the block from
the pen block menu.

3. Drag the o | |
block from the pen block RERNAAYOLT SR
menu. Figure 7.4: Drawing Shapes with Pen
4. Select the Motion block :
1 @ Let me Answer
menu and select these Is a circle 2D or 3D shape?
LT e [ len [ s ﬂ UegErL

blocks . Place these two in order, as shown in the Figure 7.5.

Repeat the directions three times given in step 4.

Computer3 | S W ¥ ekl = X === = X === ¥ ¥ TN

I




6. Click on the block stack in the script area or the I button. You
will have a circle drawn by the sprite.

| G

G o6

Figure 7.5: Drawing a Circle with a Pen

Sagar wants to move the sprite by 10 steps . He forgot how to do the same. Suggest
to him the way to accomplish the task.

- Let’s Recall !

Scratch is freely available on the web.
 The only language a computer can understand is a programming language.

o Scratch is an excellent visual programming language where we can create
interactive narratives, games and animations.

o 'The script is a step-by-step instruction that a sprite follows.
 Blocks Palette contains blocks for programming.

o The default mascot of scratch is a cat.

ERYX X I
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.~ Upskill Your Intelligence - .
: AN\/\WMM/\/V\’\/\WJ’W"\/V\N”\\ i
A. Fill in the blanks
Lo e, is an excellent visual programming language.
2. Instructions can be given to the computer using ................... blocks.
3. Scratch is freely available on the ..........................
4. bar shows the title of the project.
5. Scratch 3.0 allows drawing various shapes by stacking ....................
............................ one over another.
B. Answer the following questions.
1. What is Scratch?
2. Write down four features of Scratch.
3.  What is the use of the Menu bar?
4. What is the use of Blocks Palette?
5. Write the steps to open the Scratch application.
C. Write ‘T’ for True statements and ‘F’ for False statements.
1. A computer understands only programming language. ()
2. A scriptis also called a sprite. ()
3. A new project begins by default with the rabbit sprite. ()
X Coputer} | e W ¥ s = s === = X === ¥ X WE




4. We can create new sprites using new sprite buttons.

5. Sprite performs actions on stage.

D. Identify and name the components of the 3D-Paint window.

o LT a .

U iﬂﬁﬁiﬁﬁﬁ’ |

e,
= 00O
E. Tick (v') the correct answer.
| R is the area where sprite moves independently.

() a.Sprite () b.Script [ ) c. Stage () d. Menu

2. The cartoon mascot of scratchisa .....................

() a.Rat () b.Penguin [} c. Bird () d.Cat

3. We share our games made using scratch on the ...................
() a. Window [ ) b. Web () c. Computer( ] d. Website

4. A tiny graphic that roams around the stage on its own.

() a. Spirit () b. Spite
() c. Sprite () d. None of these
5. 'The first step to draw a circle in Scratch 3.0.
() a. Add extension () b. Select pen down
() c. Select pen size () d. Click on the block stack
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@ Critical Thinking

A. Rearrange the following words to find some components of the Scratch
3.0 window.

1. LCBOKS m et
2. NNXEETOIS - .
3. PCSTIR m et
4. ETTIL m ettt
5. EGSTA m et

B. Number the first three steps in order to draw any shape in Scratch 3.0.
o Choose the pen down block from the pen block menu. )
o Drag the set pen size to 1 block from the pen block menu. )

o Click on the ‘Add Extensions” button. The pen blocks will then be
added to the blocks menu. )

Team Work

Work in pairs. Draw the following shapes in scratch 3.0.

Computer-3
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Let’s play this game and guess who am I?

2. Small
labelled
pictures
on desktop
screen.

4. The most
popular
operation
window.

8. Move
ahead 2

7. Shows our
work done on
the computer.

5. The
brain of the
computer.

9. Parts of the

computer that

can be seen or
touched.

10. Keys
used to move
the cursor
position in

Roll a dice and play
with your friend.




B. Rahul wants to open Scratch 3.0. Help him to reach its logo.
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